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Customer Support
Control Techniques
12005 Technology Drive
Eden Prairie, Minnesota 55344-3620
U.S.A.

Telephone: (952) 995-8000 or (800) 893-2321

It is Control Techniques’ goal to ensure your greatest possible satisfaction with the operation 
of our products. We are dedicated to providing fast, friendly, and accurate assistance. That is 
why we offer you so many ways to get the support you need. Whether it’s by phone, fax or 
modem, you can access Control Techniques support information 24 hours a day, seven days 
a week. Our wide range of services include:

FAX (952) 995-8099

You can FAX questions and comments to Control Techniques. Just send a FAX to the number 
listed above.

Website and Email www.emersonct.com

Website: www.emersonct.com

Email: info@emersonct.com

If you have Internet capabilities, you also have access to technical support using our website. 
The website includes technical notes, frequently asked questions, release notes and other 
technical documentation. This direct technical support connection lets you request assistance 
and exchange software files electronically.

Technical Support (952) 995-8033 or (800) 893-2321

Email: service@emersonct.com

Control Techniques’ “Motion Made Easy” products are backed by a team of professionals 
who will service your installation. Our technical support center in Eden Prairie, Minnesota is 
ready to help you solve those occasional problems over the telephone. Our technical support 
center is available 24 hours a day for emergency service to help speed any problem solving. 
Also, all hardware replacement parts, if needed, are available through our customer service 
organization.

When you call, please be at your computer, with your documentation easily available, and be 
prepared to provide the following information:

• Product version number, found by choosing About from the Help menu

• The type of controller or product you are using
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• Exact wording of any messages that appear on your screen

• What you were doing when the problem occurred

• How you tried to solve the problem

Need on-site help? Control Techniques provides service, in most cases, the next day. Just call 
Control Techniques’ technical support center when on-site service or maintenance is 
required.

Training Services (952) 995-8000 or (800) 893-2321

Email: training@emersonct.com

Control Techniques maintains a highly trained staff of instructors to familiarize customers 
with Control Techniques’ “Motion Made Easy” products and their applications. A number of 
courses are offered, many of which can be taught in your plant upon request.

Application Engineering (952) 995-8000 or (800) 893-2321

Email: service@emersonct.com

An experienced staff of factory application engineers provides complete customer support for 
tough or complex applications. Our engineers offer you a broad base of experience and 
knowledge of electronic motion control applications.

Customer Service (Sales) (952) 995-8000 or (800) 893-2321

Email: customer.service@emersonct.com

Authorized Control Techniques distributors may place orders directly with our Customer 
Service department. Contact the Customer Service department at this number for the 
distributor nearest you.

Document Conventions
Manual conventions have been established to help you learn to use this manual quickly and 
easily. As much as possible, these conventions correspond to those found in other Microsoft® 
Windows® compatible software documentation.

Menu names and options are printed in bold type: the File menu.

Dialog box names begin with uppercase letters: the Axis Limits dialog box.

Dialog box field names are in quotes: “Field Name.”

Button names are in italic: OK button.

Source code is printed in Courier font: Case ERMS.
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In addition, you will find the following typographic conventions throughout this manual. 

Special nomenclature is provided for people working with these products, as follows:

“Warning indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury.

“Caution” indicates a potentially hazardous situation that, if not avoided, may result in 
minor or moderate injury.

“Caution” used without the safety alert symbol indicates a potentially hazardous situation 
that, if not avoided, may result in property damage.

Note
For the purpose of this manual and product, “Note” indicates essential information about 
the product or the respective part of the manual.

Throughout this manual, the word “drive” refers to an EN or MDS drive.

This Represents

bold
Characters that you must type exactly as they appear. For example, if you are directed to type 
a:setup, you should type all the bold characters exactly as they are printed.

italic
Placeholders for information you must provide. For example, if you are directed to type 
filename, you should type the actual name for a file instead of the word shown in italic type.

ALL CAPITALS Directory names, file names, key names, and acronyms. 

SMALL CAPS Non-printable ASCII control characters. 

KEY1+KEY2
example: (Alt+F)

A plus sign (+) between key names means to press and hold down the first key while you press 
the second key. 

KEY1,KEY2 
example: (Alt,F)

A comma (,) between key names means to press and release the keys one after the other. 
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Safety Instructions

General Warning 
Failure to follow safe installation guidelines can cause death or serious injury. The 
voltages used in the product can cause severe electric shock and/or burns and could be 
lethal. Extreme care is necessary at all times when working with or adjacent to the 
product. The installation must comply with all relevant safety legislation in the country 
of use.

Qualified Person
For the purpose of this manual and product, a “qualified person” is one who is familiar with 
the installation, construction and operation of the equipment and the hazards involved. In 
addition, this individual has the following qualifications:

• Is trained and authorized to energize, de-energize, clear and ground and tag circuits and 
equipment in accordance with established safety practices.

• Is trained in the proper care and use of protective equipment in accordance with 
established safety practices.

• Is trained in rendering first aid.

Reference Materials
The following related reference and installation manuals may be useful with your particular 
system.

• Epsilon Eb and E Series EN Drives Reference Manual (400501-01)

• MDS Reference Manual (400525-01)

• PowerTools Software User’s Guide (400503-01)

• FM-1 Speed Module Reference Manual (400506-01)

• FM-2 Indexing Module Reference Manual (400507-01)

• FM-3 Programming Module Reference Manual (400508-01)

• FM-4 Programming Module Reference Manual (400509-01)

• FM-3 and FM-4 Connectivity Modules Reference Manual (400508-04)
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FM Modules Installation Manual
Safety Considerations
Safety Precautions

This product is intended for professional integration into a complete system. If you install the 
product incorrectly, it may present a safety hazard. The product and system may use high 
voltages and currents, carry a high level of stored electrical energy, or control mechanical 
equipment that can cause injury.

You should give close attention to the electrical installation and system design to avoid 
hazards either in normal operation or in the event of equipment malfunction. System design, 
installation, commissioning and maintenance must be carried out by personnel who have the 
necessary training and experience. Read and follow this safety information and the instruction 
manual carefully.

Enclosure
This product is intended to be mounted in an enclosure which prevents access except by 
trained and authorized personnel, and which prevents the ingress of contamination. This 
product is designed for use in an environment classified as pollution degree 2 in accordance 
with IEC664-1. This means that only dry, non-conducting contamination is acceptable.

Setup, Commissioning and Maintenance
It is essential that you give careful consideration to changes to drive settings. Depending on 
the application, a change could have an impact on safety. You must take appropriate 
precautions against inadvertent changes or tampering. Restoring default parameters in certain 
applications may cause unpredictable or hazardous operation.

Safety of Machinery
Within the European Union all machinery with which this product is used must comply with 
Directive 89/392/EEC, Safety of Machinery.

The product has been designed and tested to a high standard, and failures are very unlikely. 
However the level of integrity offered by the product’s control function – for example stop/
start, forward/reverse and maximum speed – is not sufficient for use in safety-critical 
applications without additional independent channels of protection. All applications where 
malfunction could cause injury or loss of life must be subject to a risk assessment, and further 
protection provided where needed.
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FM Modules Installation Manual
General warning
Failure to follow safe installation guidelines can cause death or serious injury. The 
voltages used in this unit can cause severe electric shock and/or burns, and could be lethal. 
Extreme care is necessary at all times when working with or adjacent to this equipment. 
The installation must comply with all relevant safety legislation in the country of use.

AC supply isolation device
The AC supply must be removed from the EN drive and Power Module Backplane using 
an approved isolation device or disconnect before any servicing work is performed, 
removing and/or installing the Power Module and /or Drive Module(s), other than 
adjustments to the settings or parameters specified in the manual. The drive contains 
capacitors which remain charged to a potentially lethal voltage after the supply has been 
removed. Allow at least 3 minutes for MDS and Epsilon, 30 seconds for EN drives after 
removing the supply before carrying out any work which may involve contact with 
electrical connections to the drive.

Products connected by plug and socket
A special hazard may exist where the drive is incorporated into a product which is 
connected to the AC supply by a plug and socket. When unplugged, the pins of the plug 
may be connected to the drive input, which is only separated from the charge stored in the 
bus capacitor by semiconductor devices. To avoid any possibility of electric shock from 
the pins, if they are accessible, a means must be provided for automatically disconnecting 
the plug from the drive (that is, a latching contactor).

Grounding (Earthing, equipotential bonding)
The drive must be grounded by a conductor sufficient to carry all possible fault current in 
the event of a fault. The ground connections shown in the manual must be followed.

Fuses
Fuses or over-current protection must be provided at the input in accordance with the 
instructions in the manual.

Isolation of control circuits
The installer must ensure that the external control circuits are isolated from human 
contact by at least one layer of insulation rated for use at the applied AC supply voltage.
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FM Modules Installation Manual
Introduction
The Function Module (FM) is a compact and rugged module that attaches to the front of the 
EN drive and the MDS drive module. It provides eight digital input lines and four digital 
output lines, in addition to the four input and three output lines available on the drive. 

The FM-1 Speed Module offers the user eight digital Torque presets, two additional 
Summation modes, and an Alternate Operating mode.

The FM-2 Indexing Module enables the user to initiate up to 16 different indexes, jogging, 
and a single home routine.

The FM-3, FM-3E, FM-3PB and FM-3DN Programming Modules offer complex motion 
profiling. A complex motion profile consists of two or more indexes that are executed in 
sequence such that the final velocity of each index except the last is non-zero. Logical 
instructions between index statements can provide a powerful tool for altering motion profiles 
’on the fly’.

The FM-4, FM-4E, FM-4PB and FM-4DN Programming Modules offer complex motion 
profiling, along with multi-tasking user programs. A complex motion profile consists of two 
or more indexes that are executed in sequence such that the final velocity of each index except 
the last is non-zero. Logical instructions between index statements can provide a powerful 
tool for altering motion profiles ’on the fly’. 

The FM modules define complex motion by a configuration file that includes setups and 
function assignments. For the FM-3 and FM-4 modules, the configuration file also includes 
programs. The configuration file is created using PowerTools software. The FM-1 and FM-2 
modules use PowerTools-FM software, and the FM-3, FM-3E, FM-3PB, FM-3DN, FM-4, 
FM-4E, FM-4PB and FM-4DN modules use PowerTools Pro software. Setup views have the 
same look and feel as dialog boxes. The wiring of input and output functions is done through 
assignments in the software. PowerTools software is an easy-to-use Microsoft® Windows® 
based setup and diagnostics tool.
1



FM Modules Installation Manual
 Figure 1:  EN Drive with FM Module

Note that the drive’s firmware is disabled whenever a FM module is attached. Therefore, if 
the drive’s hardware is FM compatible, then the drive’s firmware can be any version because 
the programming features reside in the function module’s flash memory. Flash files used for 
firmware upgrades are available on the Control Techniques website.

The FM module stores drive setup parameters within the module itself. This allows you to 
transfer the FM module to another drive of the same model without losing setup parameters.
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Introduction
 Figure 2: FM-1 and FM-2 Module Features (FM-2 module shown)

 Figure 3: FM-3 and FM-4 Module Features (FM-4 Module shown)
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 Figure 4: FM-3E and FM-4E EtherNet Module Features

 Figure 5: FM-3DN and FM-4DN DeviceNet Module Features
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Introduction
 Figure 6: FM-3PB and FM-4PB Profibus Module Features
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Installation (All FMs)
Basic Installation Notes

You are required to follow all safety precautions during startup, such as providing proper 
equipment grounding, correctly fused power and an effective Emergency Stop circuit which 
can immediately remove power in the case of a malfunction. See the “Safety Considerations” 
section for more information.

Mechanical Installation
The FM module detects and verifies the drive serial number when it’s attached to the drive. 
If a FM module is moved from one drive to another, it will detect the difference in serial 
numbers and generate an Invalid Configuration fault (indicated by "U" on the keypad 
display). To remove an "U" fault simply hold the drive reset button for 12 or more seconds.

Two aligning tabs, a locking latch and a 100-pin connector are used to attach the FM module 
to the drive. All electrical connections between the FM module and the drive are 
accomplished with the single connector located on the rear of the FM module. 

 Figure 7: Attaching the FM Module to an E Series Drive (FM-3 shown)

Do not attach or detach the FM module when power is applied to the drive. It could cause 
drive instability and may cause property damage.

1

Grip the FM
firmly on
each side.

3

Gently press the
FM against the
drive, aligning the
100-pin connector.

4

Continue pressing the FM
against the drive until the
latch clicks into the slot
on the top of the drive.

2

Insert the
aligning tabs
into the slots
on the drive.
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 Figure 8: Detaching the FM Module from the Drive Connections

Do not attach or detach the FM module when power is applied to the drive. It could cause 
drive instability and may cause property damage.

Electrical Installation
Input/Output Wiring

The FM Modules are equipped with eight optically isolated input lines and four optically 
isolated output lines. They are designed to operate from a +10 Vdc to 30 Vdc source. All 
inputs and outputs are configured as sourcing. The user is responsible for choosing a load that 
will limit each output current to less than 200 mA.

The input lines, output lines and I/O power connectors are on removable terminal blocks. 18 
to 24 AWG stranded wire is recommended.

A single power supply can be used to power the I/O on both the drive and the FM Module, 
however, it must be wired to both the drive and the FM Module because I/O power is not 
passed through the connector on the back of the FM Module. Alternatively, separate power 
supplies can be used to power the I/O on the drive and the FM Module, as long as they share 
a common ground.

1Grip the FM
on each side
of the LCD.

4

Continue pulling the top
of the FM away from the
drive until the connector
clears the drive. Lift the
FM out of the aligning
tab slot and away from
the drive.

3

Gently pull the FM away from
the drive. A slight rocking
motion may be used to loosen
the FM's connector.2

Press down on the
latch located on
the top of the FM.
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Installation (All FMs)
 Figure 9: Input/Output Sourcing Wiring Diagram (FM-4 module/EN drive shown)

For more information about wiring and cables, please refer to the reference manual for the 
specific FM module.
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Modbus Communications
The drive’s serial communication protocol is Modbus RTU slave with a 32 bit data extension. 
The Modbus protocol is available on most operator interface panels and PLC’s.

Control Techniques’ Motion Interface panels are supplied with a Modbus master 
communications driver.

Software Installation
PowerTools-FM and PowerTools Pro software was designed for users who need access to all 
setup options and diagnostic information for the drive. The software provides access to all 
commonly used drive parameters.

PC System Configuration
Required:

• Microsoft® Windows® 98, Microsoft® Windows NT® 4.0 (service pack 3), Microsoft® 
Windows 2000, and Microsoft® Windows XP (Home and Pro)

• Serial port

• Mouse

• CD-ROM drive

• Microsoft® Internet Explorer v 4.0 or greater

Recommended:

• 16 MB or more RAM for Windows 98, and 32 MB or more for Windows NT and 
Windows 2000 and 64MB or more for Windows XP.

• Up to 45 MB of hard disk space required for a full installation; 15 MB for minimum 
installation.

Optional:

• Windows-compatible printer

• Modem and Internet access

Serial Communications Specifications

Max baud rate 19.2k (default)

Start bit 1

Stop bit 2

Parity none

Data 8
10



Installation (All FMs)
Preparing for PowerTools Installation
• Close all programs and turn off virus protection software to prevent installation conflicts.

• If you have another version of PowerTools on your computer and do not want to overwrite 
that version, change the default installation folder for PowerTools during installation 
setup.

• To avoid overwriting programs you have customized or created, place them into a 
separate folder before you install.

Installing PowerTools Software
You must be running Microsoft Windows 98, Microsoft Windows NT 4.0, Microsoft 
Windows 200 or Microsoft Windows XP to install this software.

1.  Insert the Control Techniques Power CD into the CD-ROM drive. Navigate to the 
PowerTools-FM or PowerTools Pro installation link. 

OR

If installing from the website, when prompted, save the software to your hard drive. Use 
Windows Explorer, navigate to the PTFM.exe or PTPro.exe file which is now on your hard 
drive. Then, double click on the PTFM.exe or PTPro.exe file.

2. Click the OK button, then follow the instructions on your screen.

Installation will take a few minutes. The install program automatically:

• Creates the directory on your hard drive named either:

C:\Control Techniques\PT-FM
 or 
C:\Control Techniques\PowerTools Pro - (version#)

• Creates a new Windows group called Control Techniques.

• Loads PowerTools into the Control Techniques\PowerTools-FM or Control 
Techniques\PowerTools Pro - vX.XX directory.

Note
To complete the installation for Windows 98, NT and 2000, you may be required to restart 
Windows.

Refer to the readme.txt file located at the end of the installation for more information.

If You Need Help with Installation
If you encounter problems while installing PowerTools software, call Technical Support at 
(952) 995-8033 or (800) 893-2321 (24 hour assistance).
11
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Starting and Exiting PowerTools Software
Starting the Software

1.   Click the Start button on the taskbar at the bottom left of the screen.

2.   Click on the Programs selection. The Programs menu appears.

3.   Click on the “Control Techniques” folder icon.

4.   Click on the “PowerTools” folder icon.

or

5. Click on the PowerTools program icon.

or

Opening a New File
To start a new file or configuration, select File from the menu bar, and then select New. You 
may also click on the File New button on the toolbar. 

The New dialog box will appear prompting the user to select the Drive Setup pertinent to the 
FM module in use.

 Figure 10: PowerTools-FM New Configuration Dialog Box
12
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 Figure 11: PowerTools Pro New Configuration Dialog Box

Note
If the module is DeviceNet compatible (FM-3DN or FM-4DN printed on front panel), 
then select FM-3DN or FM-4DN Drive Setup. If the module is Profibus compatible (FM-
3PB or FM-4PB printed on front panel) then select FM-3PB or FM-4PB Drive Setup. If 
the module is EtherNet compatible (FM-3E or FM-4E printed on front panel), then select 
FM-3E or FM-4E Drive Setup. If the module is intended solely for Modbus 
communications (FM-3 or FM-4 printed on front panel), then select FM-3 or FM-4 Drive 
Setup.

This will create a new file in which you will construct the entire FM module setup.

Exiting the Software
Choose File from the menubar, then click Exit. If you are using the keyboard, press the 
shortcut key combination Alt+F, X.

If you made changes, PowerTools displays an Alert dialog box asking whether you want to 
save your current work. Click the Yes button or press Enter to save your work, or click the No 
button to quit without saving.

Accessing Help
All PowerTools views and dialog boxes provide a Help button. This retrieves help for that 
particular subject and provides details to assist you in the use of each view or dialog box. 
Also, provided is a index-based help system. There is the ability to search the online help 
using a keyword. Lastly, PowerTools has context sensitive help capability.

Online Help displays detailed procedural and reference information. It contains some 
information that does not appear in this manual.

To display Help in PowerTools, do one of the following:

• Press F1.
13
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• Choose a command from the Help menu.

• Click the Help button on a dialog box or view.

• Click the Help button on the toolbar.

• Click the Context Sensitive Help button on the toolbar and then click on the field in the 
view.
14
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DeviceNet Installation
(FM-3DN and FM-4DN only)

Basic Installation Notes
You are required to follow all safety precautions during start-up, such as providing proper 
equipment grounding, correctly fused power and an effective Emergency Stop circuit which 
can immediately remove power in the case of a malfunction. See the “Safety Considerations” 
section for more information.

Wiring
The DeviceNet wiring for the FM-3DN and FM-4DN modules follow the ODVA standard 
documented in the DeviceNet Specification Volume II.

 Figure 12: DeviceNet Wiring Connection

Wire Locations Wire Colors

V- Black

Can_L Blue

Drain

Can_H White

V+ Red
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The FM-3DN and FM-4DN modules support both Multi-Tap and Multi-Drop (Daisy 
Chaining) wiring configurations. Figures 13 and 14 show typical configurations.

 Figure 13: Multi-Tap DeviceNet Configuration and Wiring
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BLACK
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 Figure 14: Multi-Drop DeviceNet Configuration and Wiring

Changing the MacID and BaudRate
MacID and BaudRate can be changed on the keypad on the front of the FM Module.

1. Use the soft key under menu and the arrow keys on the keypad to scroll through the menu 
to DVNet. Select it.

2. Scroll through the parameters with the up and down arrows.

a. To change the MacID, scroll to MacID; click modify; use the up and down arrows to 
change the setting; click OK.

BLACK
BLUE

SHIELD

WHITE

RED

BLACK
BLUE
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WHITE

RED

V-
CAN_L
DRAIN
CAN_H
V+

Insert Term 
Resistor
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b. To change the BaudRate, scroll to BaudRate; click modify; use the up and down arrows 
to change the setting; click ok. After a BaudRate change, cycle the power to the drive.

BaudRate and MacID can also be changed through the DeviceNet View in PowerTools Pro 
software. See FM-3 and FM-4 Connectivity Reference Manual (P/N 400508-04) for more 
information. 
18
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Profibus Installation
(FM-3PB and FM-4PB only)

Mechanical Installation  
Follow the instructions for mechanical installation of an EN and FM-3 as detailed in the EN-
Series Installation Manual (P/N 400501-02).

Profibus Hardware Components
The following components are necessary to design a Profibus communications system:  
cables, Nodes/devices, Connectors, Power Supplies, Terminating resistors.

• Cables: Profibus cabling consists of a 2 wire twisted pair with a braided shield. Control 
Techniques offers this cable as model number PBC CABLE-xxx. 

 Figure 15: Cross-sectional view of the PBC Cable-XXX 

• Nodes/Devices: A Profibus node is any device that is addressable through Profibus Media 
and contains Profibus communications circuitry.  Profibus Slaves must comply with the 
following:  Slaves must be Profibus-compatible devices.  126 Slaves can be supported on 
one network.  Each Slave must be assigned a unique Profibus node address.

• Connectors: Due to the high speed nature of the Profibus network, the recommended 
connector is a 35 degree Siemens Profibus Connector. Control Techniques offers this 
connector as model number PBCONN.
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 Figure 16: Recommended Connector for Profibus Communications

• Terminating Resistors: Terminating resistors are used to reduce the reflection of signals 
over the network. Due to the high bit rates of Profibus, terminating resistors must be used 
at both ends of the network in order to guarantee communications stability. When using 
the Profibus connector offered by Control Techniques, the terminating resistor is built into 
the connector and is turned on when the red switch on the back of the connector is turned 
to the “on” position. When not using this connector (not recommended) terminating 
resistors of 220 ohms must be installed between A and B.

Electrical Installation
Physical Connections to the Profibus Network:  A two wire configuration is used to connect 
the FM-3/4PB to the Profibus network.  When multiple FM-3/4PB nodes are connected to the 
network, connectors will be daisy chained by making use of the incoming and outgoing lines.

Pin Number Name Insulation Color Direction

8 A1 Green Incoming

3 B1 Red Incoming

8 A2 Green Outgoing

3 B2 Red Outgoing

PBCONN

35  Cable outleto
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 Figure 17: Connector Wiring

The connector provided for Profibus is a standard DB9 female connector.  

A1 B1 A2 B2

Cable shield must make
good contact with the metal
part.

Switch = “OFF”
(terminating resistor
deactivated)
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Ethernet Installation
(FM-3E and FM-4E only)

Basic Installation Notes
You are required to follow all safety precautions during start-up, such as providing proper 
equipment grounding, correctly fused power and an effective Emergency Stop circuit which 
can immediately remove power in the case of a malfunction. See the “Safety Considerations” 
section for more information.

Wiring
The Ethernet wiring uses a category 5 cable (Control Techniques’ model# ETH-PATCH-xxx) 
and follows the Ethernet/IP specification.

 Figure 18: Ethernet Module Connections

Aligning Tabs

Outputs

10-30 Vdc

Inputs

Direction Arrow
Keys

Soft Keys

3 Row by 12 
Character Display

Ethernet

Sync. Input

Sync. Output
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Front

Ethernet

Side
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The FM-3E and FM-4E modules support both  Switch and Hub wiring configuration.  Figure 
19 show a typical configuration.

 Figure 19: Multi-Tap Ethernet Configuration and Wiring

Changing the IP Address, Subnet Mask and Gateway
Keypad Interface

Like all of the standard FM-3 and FM-4 module parameters, discussed in the “Operational 
Overview” chapter of the FM-3 Programming Module Reference Manual (P/N 400508-01) 
and FM-4 Programming Module Reference Manual (P/N 400509-01), the Ethernet system 
parameters can be edited from the keypad display (LCD) on the front of the FM-3E or FM-
4E module. The keypad on the front of the FM-3E and FM-4E module provides navigation 
through a menu of common parameters and displays current functions. Navigation through 
the menu is accomplished with the six keys located below the display. The top two keys are 
called the “soft keys” because they relate to the commands located directly above each key 
on the display. These keys are used to select the operation (i.e. Modify, Ok, Cancel), 
parameter group, and/or to validate information. The four arrow keys are used to navigate 

E
th

ern
et

Switch or Hub
E

th
ern

et

ETH-PATCH-xxx
3’, 5’, or 10’

ETH-PATCH-xxx
3’, 5’, or 10’

PLC or HMI
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through parameter groups, select a specific parameter to be modified, and to modify digital 
and numeric data.

The operation of the arrow keys is dependent upon the type of parameter which is being 
modified.

Software
The IP Address, Subnet Mask and Gateway can also be changed on the Setup view in 
PowerTools Pro.
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Diagnostics and Troubleshooting
(All FMs)

Diagnostic Display
The diagnostic segment display on the front of the drive shows drive status, FM module 
status, and fault codes. When a fault condition occurs, the drive will display the fault code, 
overriding the status code. The alphanumeric display on the FM module provides additional 
fault information. 

The decimal point is “On” when the drive is enabled, and the stop input is not active. This 
indicates that the drive is ready to run and any motion command will cause motion. Motion 
commands will not cause motion unless you are Ready (R) and the decimal point is “On”.

Display 
Indication Status Description FM-3/FM-4 Keypad 

Display Applicable FM Module

Brake Engaged (Output 
"Off")

Motor brake is mechanically 
engaged. this character will only 

appear if the Brake Output function is 
assigned to an output line. 

N/A FM-1, FM-2

Ready
The FM module and drive system is 
functioning normally and is ready to 
execute a motion command.

Drive Type         Address
Motor Type
Menu Groups

All

Disabled Power Stage is disabled.
Drive Type         Address
Motor Type
Menu Groups

All

RMS Foldback Motor torque is limited to 80 percent.
Drive Type         Address
Motor Type
Menu Groups

All

Stall Foldback
Drive output current is limited to 80 
percent of drive stall current. 

Drive Type         Address
Motor Type
Menu Groups

All

Ready to Run Drive enabled. No stop input.
Drive Type         Address
Motor Type
Menu Groups

All
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Fault Codes
A number of diagnostic and fault detection circuits are incorporated to protect the drive. Some 
faults, such as high DC bus and amplifier or motor over temperature can be reset with the 
Reset button on the front of the drive or the Reset input function. Other faults, such as encoder 

Homing Home is executing. 
Drive Type         Address
Motor Type
Menu Groups

FM-2, FM-3, FM-3DN, 
FM-3PB, FM-4, FM-
4DN, FM-4PB 

Indexing Index is executing.
Drive Type         Address
Motor Type
Menu Groups

 FM-2, FM-3, FM-3DN, 
FM-3PB, FM-4, FM-
4DN, FM-4PB 

Jogging Jog is executing.  
Drive Type         Address
Motor Type
Menu Groups

FM-2, FM-3, FM-3DN, 
FM-3PB, FM-4, FM-
4DN, FM-4PB 

Position Waiting for command (Pulse mode). N/A FM-1

Program Program is executing. 
Drive Type         Address
Motor Type
Menu Groups

FM-3, FM-3DN, FM-
3PB, FM-4, FM-4DN, 
FM-4PB

Velocity Velocity mode operation N/A FM-1

Torque Torque mode operation N/A FM-1

Summation Summation mode operation N/A  FM-1

Stop or Travel Limit 
Decel

Stop or Travel Limit Decel in 
progress. 

N/A FM-2

Display 
Indication Status Description FM-3/FM-4 Keypad 

Display Applicable FM Module
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faults, can only be reset by cycling power “Off” (wait until the diagnostics display turns 
“Off”), then turning power “On”.

The drive accurately tracks motor position during fault conditions. For example, if there is a 
"Low DC Bus" fault when the power stage is disabled, the drive will continue to track the 
motor’s position provided the logic power is not interrupted.

The +/- Limit faults are automatically cleared when the fault condition is removed. The table 
below lists all the fault codes in priority order from highest to lowest. This means that if two 
faults are active, only the higher priority fault will be displayed.

Segment 
Display Fault Action to Reset Bridge 

Disabled
FM-3/FM-4 

Display
Applicable FM 

Module

Flash Invalid
Reprogram the FM’s 
Flash

Yes All

Power Up  Test Cycle Power Yes Power Up Tst All

NVM Invalid
Reset Button or 
Input line

Yes NVM Invalid All

Invalid Configuration
Reset Button or 
Input line

Yes Invalid Conf All

Power Module
Reset Button or 
Input line

Yes Power Module All

High DC Bus 
Reset Button or 
Input line

Yes High DC Bus All

Low DC Bus 
Reset Button or 
Input line

Yes Low DCBus All

Encoder State Cycle Power Yes Encoder State All
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Encoder Hardware Cycle Power Yes Encoder HW All

Motor Overtemp
Allow motor to cool 
down, Reset Button 
or Input line

Yes MotorOvrTemp All

RMS Shunt Power
Reset Button or 
Input line

Yes RMS ShuntPowr All

Overspeed
Reset Button or 
Input line

Yes Over Speed All

Max Following Error 
Reset Button or 
Input line

Yes Following Err All

Travel Limit +/- Auto No
TravLmtMinus 
TravLmtPlus

All

All "On"
Normally on for one 
second during power 
up

Yes All

FM-3
Reset Button or 
Input line

Yes
** Fault **

<Fault Description>
FM-3, FM-3DN, 

FM-3PB

FM-4
Reset Button or 
Input line

Yes
** Fault **

<Fault Description>
FM-4, FM-4DN, 

FM-4PB

DeviceNet or Profibus Reset Button
Dependent on 

Fault
** Fault **

<Fault Description>
FM-3DN, FM-4DN, 
FM-3PB, FM-4PB

Segment 
Display Fault Action to Reset Bridge 

Disabled
FM-3/FM-4 

Display
Applicable FM 

Module
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Fault Descriptions

 Figure 20: FM-3 and FM-4 Module display is used to display drive and FM faults

Flash Invalid

This fault indicates that the firmware checksum has failed. Use the Tools> Program> Flash 
menu item from PowerTools software to reprogram/upgrade the firmware stored in flash 
memory. If this problem persists, call Control Techniques. A common cause would be an 
interrupted F/W Flash upgrade (cable disconnected during an upgrade process).

Power Up Test 

This fault indicates that the power-up self-test has failed. This fault cannot be reset with the 
reset command or reset button.

NVM Invalid

At power-up, the drive tests the integrity of the non-volatile memory. This fault is generated 
if the contents of the non-volatile memory are invalid.

Invalid Configuration

The FM was not on this drive during its previous power-up and it is not known if the setup 
data in the FM matches the drive and motor to which the FM is now attached. 

This can also happen when a FM is removed from a drive and the drive is powered-up.

To reset the fault, create or open a configuration file with the correct drive and motor 
selections and download the configuration to the FM or drive. If you are certain that the setup 
data in the FM or drive matches the system configuration, press and hold the drive’s Reset 
button for 10 seconds (until the fault is cleared).

E N - 2 0 4 A D R 0 1
MG - 3 1 6
S E C U R Q U I C K
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Drive instability and resultant property damage may occur to the drive, motor or both if 
the fault is cleared using the Reset button when the setup data in the FM does not match 
the current drive and motor.

Power Module

This fault is generated when a power stage over-temperature, over-current or loss of power 
stage logic supply occurs. This can be the result of a motor short to ground, a short in the 
motor windings, a motor cable short or the failure of a switching transistor.

It can also occur if the drive enable input is cycled "Off" and "On" rapidly (>10 Hz).

High DC Bus

This fault will occur whenever the voltage on the DC bus exceeds 440 VDC. The most likely 
cause of this fault would be an open shunt fuse, a high AC line condition or an application 
that requires an external shunt (that is, a large load with rapid deceleration).

Low DC Bus

This fault will occur whenever the voltage on the DC bus drops below 96 volts. The most 
likely cause of this fault is a reduction (or loss) of AC power. A 50 ms debounce time is used 
with this fault to avoid faults caused by intermittent power disruption.

Encoder State

Certain encoder states and state transitions are invalid and will cause the drive to report an 
encoder state fault. This is usually the result of noisy encoder feedback caused by poor 
shielding.

Encoder Hardware

If any pair of encoder lines are in the same state, an encoder line fault is generated. The most 
likely cause is a missing or bad encoder connection.

Motor Overtemp

This fault is generated when the motor thermal switch is open due to motor over-temperature 
or incorrect wiring.
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RMS Shunt Power

This fault is generated when RMS shunt power dissipation is greater than the design rating of 
the internal shunt.

Overspeed

This fault occurs when the actual motor speed exceeds the Overspeed Velocity Limit 
parameter. This parameter can be accessed with PowerTools Pro software.

Max Following Error

This fault is generated when the following error exceeds the following error limit (default 
following error limit is .2 revs). With PowerTools Pro  you can change the Following Error 
Limit value on disable in the Position view.

Travel Limit +/-

This fault is caused when either the + or - Travel Limit input function is active.

All "On"

This is a normal condition during power up of the drive. It will last for less than 1 second. If 
this display persists, call Control Techniques for service advice.

 or FM-3  or FM-4 Fault

A 3 or a 4, as appropriate, will be displayed in the segment display on the drive when the FM 
experiences one of the following faults. 

Traj Fault

This fault occurs when the drive has received trajectory data from the FM module that 
indicates a problem. Check the user units, velocities, accels and decels for correct values.

No Prog

This fault will be displayed on initial power-up indicating that no configuration has been 
downloaded to the FM module. To clear the fault, download a valid configuration to the FM 
module.

OutofSync

This fault is generated when the system is out of sync. To correct it, press the reset button and 
check the configuration.
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ProgramFault

This fault indicates an FM-3 or FM-4 user program fault. For example the program is 
attempting to divide by zero, or overflows and math errors caused by numbers that are too 
large, or non-existing parameters.

ProgramInvalid 

The user program in flash memory will not run.  Download the User Program again using 
PowerTools Pro. A common cause of this problem could be an interrupted configuration 
download, such as a cable being disconnected during a download.

DeviceNet or Profibus Fault

This fault indicates a failure in the DeviceNet or Profibus network.  This fault could be caused 
by a major unrecoverable, minor unrecoverable, or major recoverable. Major faults disable 
the bridge; minor faults do not disable the bridge and will clear themselves after a timed 
period. The particular error will be displayed on the FM module keypad display.

Drive Faults
The Active Drive Faults dialog box is automatically displayed whenever a fault occurs. There 
are two options in this dialog box: Reset Faults and Ignore Faults. 

Resetting Faults
Some drive faults are automatically reset when the fault condition is cleared. Others require 
drive power to be cycled or the drive to be “rebooted” to be cleared. If you wish to continue 
working in the PowerTools software without resetting the fault, click the Ignore Fault button.

To reset faults that can be reset with the Reset Faults button, simply click the Reset Faults 
button in the Drive Faults Detected dialog box or push the Reset button on the front of the 
drive where the fault occurred.

Viewing Active Drive Faults
To view all active drive faults, select the View Faults command from the Device menu. The 
dialog box displayed is the same as Active Drive Faults dialog box described above.

Rebooting the Drive
To reboot the drive, cycle power or select the Reboot Drive command from the Device menu. 
This command reboots the drive attached to the active Configuration Window.
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Error Messages
Error Messages (FM-1, FM-2)

PowerTools-FM will pop-up an error message box to alert you to any errors it encounters. 
These message boxes will describe the error and offer a possible solution. 

The table below list the of common problems you might encounter when working with 
PowerTools-FM software along with the error message displayed, the most likely cause and 
solution.

Error Messages (FM-3, FM-3DN, FM-3E, FM-3PB, FM-4, FM-4DN, FM-4E, FM-4PB)

PowerTools Pro will pop-up an error message box to alert you to any errors it encounters. 
These message boxes will describe the error and offer a possible solution. 

Problem/Message Cause Solution

Time-out while waiting for device response. 
The attempted operation has been cancelled. 

(see fault: No device selected)
Loss of serial communications.

Check the serial connection to the device and 
try operation again.

The attached device(s) do not have valid 
revisions, or do not have matching revisions.

Attempting to broadcast to drive without 
matching firmware revisions.

Program each drive individually.

Unable to communicate with device [Address 
x]

The device that you are attempting to 
communicate with is no longer available.

Check all connections and verify that you are 
using the correct baud rate then try again.

The specified drive type (name) does not 
match the actual drive type (name). Please 

make necessary corrections.

The drive type you selected in the “Drive 
Type” list box does not match the drive you 

are downloading to.

Change the drive type selected in the “Drive 
Type” list box to match the drive you are 

downloading to.

Non-Control-Techniques device attached 
(address). When trying to program more than 
one drive, only EMC drives of the same type 

can be attached to the network.

This error is caused When you attempting to 
perform an upload or download to multiple 
drives and one or more of the drives are not 

the same type.

Disconnect the device(s) that has been 
specified and try the operation again or 

program each device individually.

You have changed a parameter which will 
not take effect until the drive has been 

rebooted. Before you reboot the drive, you 
will need to save your setup to NVM. Do you 
wish to save your setup to drive NVM now?

See message. Yes/No.

(Operation Name) The attempted operation 
has been cancelled.

Communication error. Retry operation. Check connection to drive.

Invalid entry. The entry exceeds the precision 
allowed by this field. The finest resolution 

this field accepts is (value).
Entered a value out of range.

Enter a value within the range of that field. 
The status bar displays information on the 

currently selected object or action.

The device was disconnected during the 
upload. The upload was not complete.

Connection to the device was lost (a time-out 
occurred).

Check the connection to the device and try 
again.

The device was disconnected during the 
download. The download was not complete.

Connection to the device was lost (a time-out 
occurred).

Check the connection to the device and try 
again.

No device selected.
The device you are attempting to 

communicate with is not responding.

Check all connections.
Verify the baudrate.

Verify that the "Maximum Node Address" 
value is at least the value of the address of the 

drive connected.
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The terms below appear in the list the of common problems you might encounter when 
working with PowerTools software along with the error message displayed, the most likely 
cause and solution.

Assign means to set a value using an equation.  For example, x = 2, you are assigning the 
value of 2 to x.

A Boolean value is a value that represents two states such as On or Off.  In the FM-,3 there 
are three variable types that have Boolean values.  They are Boolean Variables, Input Event 
Variables and Output Event Variables.  They all have a Boolean Value and can be used in 
equations to assign their Boolean value to another variable or in a conditional test.

In an equation, conditional tests such as (vel > 3.1) become Boolean values.

In FM-3/FM-4 Programming, unquoted text names are used to represent Boolean constants.  
Several different names are available.  They all represent the two Boolean states and therefore 
are interchangeable.

 An Expression is a collection of mathematical operands (variables, constants and numbers) 
and operators( +, -, *, <, >, etc) that form a value.  The right hand side of an equation (to the 
right of the =) is an expression. 

The Parser is an internal component of PowerTools software that reads your program text 
file and generates executable code used by the FM-3/FM-4 Module firmware.  The parser 
detects errors that are reported to you as Red Dot Error Messages.

Your program errors are displayed in the program view in Red Dot Error Messages.  They 
are indicated with red dots.  To get further information on the cause of the error you use the 
programming tool bar’s red dotted question mark. This is an on/off setting that enables error 
message displays and application help messages.

Non-Programming Error Messages (FM-3, FM-3DN, FM-3E, FM-3PB, FM-4, FM-4DN, 
FM-4E, FM-4PB)

These messages occur while you are working in a view other than the Program View.  The 
Program View has error messages specific to it, and they are described in a Programming 
Error Messages section. The Popup messages are listed below. 

Can Not Add Index, until current is valid.,
Can Not Add Jog, until current is valid.,
Can Not Add Program, until current is valid.

The current View must be valid before you can create a new instance of Index, Jog or Home.

Error: The maximum limit of Instances is reached.

The number of Index instances, Jog Instances and Home Instances is limited.  If you attempt 
to add an instance and the number of existing instances is at the maximum, you will get this 
message.
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Programming Error Messages (FM-3, FM-3DN, FM-3E, FM-3PB, FM-4, FM-4DN, FM-
4E, FM-4PB)

These Red Dot Error messages occur while you are working in the Program View. 

When creating a program, the parser is executed when you  left mouse click,  when you arrow 
off the current Line, when you enter the carriage return, when you paste or when you drop a 
drag source.  The parser detects errors and marks the line with a “Red Dot”.  To get further 
information on the cause of the error you use the programming tool bar’s red dotted question 
mark. This is an on/off setting that enables error message displays and application help 
messages.

Problem/Message Cause Solution

Your Application is not valid to 
download ...

There are errors such as "Red Dot" errors in one or 
more programs that prevent the program from 

being downloaded to the module.

The message will provide more information 
such as which program is invalid to help the 

user correct the problem.

Your Application has ...

There are errors such as "Red Dot" errors in one or 
more programs.  The operation (i.e. file save) was 

completed, however other operations such as 
download would fail for this application.

The message will provide more information 
such as which program is invalid to help the 

user correct the problem.

A FM-3/FM-4 number’s decimal 
Point resolution can not be greater 

than ten

The FM-3/FM-4 does not use standard floating 
point.  It uses Integer arithmetic to prevent round 
off errors.  Decimals are used, but decimal point 
position is handled separately from the integer 

value.  Zero puts the decimal point to the far right.  
Ten puts the decimal point at the far left.

The decimal point position must be between 
zero and ten.

A FM-3/FM-4 number’s mantissa 
must be between -2147483647 and 

2147483647

The mantissa must be between -2147483648 and 
214748364.  

The decimal point position must be between 
zero and ten.

A numeric variable can only be 
assigned a numeric value

The Variable is a numeric.  It only accepts types 
consisting of numeric values.

A string variable can only be 
assigned a quoted text string

The Variable is string.  It only accepts types 
consisting of text strings.

Can only compare(>,<,etc) numeric 
results

This message occurs in conditional Expressions 
(i.e. If then).  Variables are type identified, so 

equation and assignments (x = 9) can be verified.  
In an expression only numerical values can be 

compared for greater than and less than conditions.

Could not find the variable See message.

Could not find the variable defined 
by program text

See message.

Destination Event variables can 
only be assigned an Event or 

Boolean

The Variable is an Input event.  It only accepts 
types consisting of Boolean, and events.

Program Instance does not Exist
You attempted the “Call Program.#”, but the 

program does not exist.

Single value expressions can only 
be Boolean constants, Events or 

Boolean variables

This message occurs in conditional Expressions 
(i.e. If then).  Variables are type identified, so 

equation and assignments .(x = 9) can be verified. 

In an expression you can use single variables 
without a comparison, but , then they must be 

a Boolean constants, Events or Boolean 
variable.
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String does not represent a 
predefined name...

The string needs to match one of the defined strings 
on record in the FM-3/FM-4 Registry data base.

String is not a selection
The string matches  one of the defined strings, but 

that string is not a selection.

Syntax error encountered
Parser Error Message.  The Parser can not 

understand your text sequence.

Text Strings are limited to 12 
characters...

To change a Name you assign a quoted text string 
to that name.  In FM-3/FM-4, text strings are fixed 

at 12 characters.  If you use fewer than 12 
characters, blanks are automatically inserted.  An 
error occurs if you attempt to use more than 12 

characters.

The Boolean variables can only be 
assigned an Event or Boolean value

The Variable only accepts types consisting of 
Boolean, and events. 

The destination variable does not 
accept Data

The Variable’s internal data type attribute was not 
found.

The destination variable does not 
accept negative numbers

You attempted to assign a negative number to an 
unassigned variable .

The destination variable is Read 
Only

This message occurs when trying to assign a value 
to a read only variable.

The destination variable only 
accepts a numeric value

See message.

The destination variable only 
accepts a Boolean or Event value

See message.

The destination variable only 
accepts quoted "text"

See message.

The destination variable only 
accepts selection text

See message.

The destination variable's 
resolution is less than the resolution 

of the number

You attempted to assign a number with a greater 
resolution of decimal points than the variable will 

accept (ie index.0.vel = 2.34567).  

The User Units setup will allow you to define 
the desired decimal point resolution.

The number is outside the range of 
the destination variable

You attempted to assign a number that is outside 
the variable’s range.

To determine the range comment out this 
instruction and use the red dot help on the 

variable. 

The mix of variable or expressions 
types can not be added or 

subtracted

This message occurs in equations.  Variables are 
type identified, so equation and assignments (x = 9) 

can be verified.  In an equation only numerical 
values can be multiplied or divided.  Booleans, 
Selections, text and events can not be added.

The mix of variable or expressions 
types can not be compared(=)

This message occurs in conditional Expressions 
(i.e. If then).  Variables are type identified, so 

equation and assignments (x = 9) can be verified.  
In an expression numerical, Boolean and event 
values can be compared for equality conditions.  

Selections and text can not be used.

The mix of variable or expression 
types can not be multiplied or 

divided

This message occurs in equations.  Variables are 
type identified, so equation and assignments (x = 9) 

can be verified.  In an equation only numerical 
values can be multiplied or divided.  Booleans, 

Selections, text and events can not be compared.

Problem/Message Cause Solution
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Diagnostics and Troubleshooting (All FMs)
The Source Event- <variable 
name> can only be assigned <max 

number> times

The limits to Source Event assignments are the 
number of destinations assigned to a single Output 

event is limited.  Generally this is three.  For 
Selections it is one.  The Waitfor Instruction 

temporarily assigns its Output Event Operands.  
This is subject to the assignment limitations.

To use an Output Event in a waitfor 
instruction, there must be at least one free 

assignment.

The Selection variable can only be 
assigned a Selection value

The destination variable only accepts selection 
values.  Selection values are fixed unquoted text.   

The selection text must exactly match the available 
selections of the Destination variable.

This instance does not exist

This variable is referencing an instance that has not 
been created in your application.  For example 

“Index.9.vel” the instance 9 of index has not been 
defined.

This is not a fully qualified variable

To use a variable it must be fully defined. Some 
variables are global variables and only the name is 

defined. Other Variables require a name.name 
convention.  Other variables require an instance 

number (index.1.vel). All the components 
identifying the variable must be available to qualify 

the variable.

This variable cannot be assigned a 
selection value

The variable that you are attempting to define with 
a selection does not accept selection values.

This variable type cannot be 
assigned a value

The Variable is of a type that does not accept any 
assignments.  A Source Event variable is an 

example.  You can not assign a value to an output 
event.

The selection is not valid for this 
variable

The variable that you are attempting to define with 
a selection does accept selection values.  However 

the selection you are attempting to use is not 
accepted by this variable.

Trying to assign a selection variable 
with bad selection data

When checking to see if the selection goes with the 
destination variable, the source is not a defined 

selection for the destination variable.

Problem/Message Cause Solution
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Online Status Indicators
Watch Window (PowerTools-FM)

This feature allows you to customize a window to monitor drive parameters which you select 
from a complete list of drive parameters. From this window you can watch the parameters you 
selected in real time. This feature is only available when you are online with the drive.

Note
You cannot change the values of the parameters while they are being displayed in the 
Watch Window. The parameter in the setup screens will look like they have been changed 
when they actually have not.

Note
It is normal to have the Watch Window show up with the three motor parameters already 
selected. If you do not need to view them, simply push the Clear All button and select the 
parameters you wish to view.

 Figure 21: Watch Window

Note
Parameters selected and displayed in the Watch Window cannot be updated from the tabs. 
To update a parameter, delete it from the Watch Window selection.

The Watch Window is accessed by selecting Watch Drive Parameters from the Tools menu 
or by clicking on the Watch Window icon on the toolbar.

The Watch Window will automatically appear as soon as you select a parameter from the 
Select Drive Parameters dialog box. After you have selected the parameters you wish to 
watch, click the Close button. The Select Drive Parameters dialog box will close and the 
Watch Window will remain open.
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Diagnostics and Troubleshooting (All FMs)
 Figure 22: Select Drive Parameters Dialog Box

Select Drive Parameters Dialog Box
This list box enables you to view the complete list of parameters or just a group of parameters 
you are interested in. The groups include: Analog Out, Communication, Digital Inputs, 
Digital Outputs, Fault Counts, Fault Log, Home, ID, Input Functions, Jog, Motion 
Commands, Motor, Output Functions, Position, Setup, Status, Torque, Tuning, User Defined 
Motor, Velocity.

Clear All Button

This button is used to clear all the parameter selections that were previously selected.

Save Selections Button

This button saves the parameter selections. This enables you to restore the same list of 
parameters for use in future online sessions.

Restore Selections Button

This button restores the parameter selections previously saved. This enables you to restore the 
list of parameters you created in a previous online session.

Watch Window (PowerTools Pro)
Power Tools Pro contains a diagnostic utility called the Watch Window.  The Watch Window 
can be used while Power Tools Pro is running and the PC is online with the FM-3/4 module.  
The Watch Window allows the user to monitor the status of all their desired system 
parameters in one location.  An example of the Watch Window is found in Figure 23 below.

To setup the Watch Window, select Tools>Watch Window from the Power Tools Pro menu 
bar.  If not online with the module, Watch Window will be unavailable on the menu.  Upon 
selecting Watch Window, the following window will appear.
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 Figure 23: Watch Window

The Select Drive Parameters window as seen in Figure 24 allows the user to specify which 
parameters are to be seen in the Watch Window.  To select a parameter for the Watch 
Window, simple click once on the parameter and it will be added to the Watch Window.  The 
parameters already in the Watch Window will be highlighted in the Select Drive Parameters 
window.

 Figure 24: Select Drive Parameters Dialog Box

Once a parameter is added to the Watch Window, its current value or state is constantly 
monitored.  If a parameter in the window changes value or state, it will change to a red color.  
It will remain red until it hasn’t changed for a period of 4 seconds.  After 4 seconds, the 
parameter will turn back to black in color.  This allows the user to see what has changed 
recently without looking directly at every parameter.
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Diagnostics and Troubleshooting (All FMs)
The following are descriptions of the buttons and controls on the Select Drive Parameters 
window:

Clear All  – By clicking on the Clear All button, all of the parameters in the Watch Window 
will be erased.

Save Selections – By clicking on Save Selections, the user can save the specific parameters 
that have been added to the Watch Window.  Once the selections have been saved, the Restore 
Selections button can be used to monitor all the same parameters the next time the user opens 
the Watch Window.  Therefore, if there is a list of helpful diagnostic parameters the user 
wishes to see when online, those specific parameters can be saved and recalled in the Watch 
Window at any time.  The settings are saved in a file named “fm3watch.wch”.

Restore Selections – By clicking on the Restore Selections button, the Watch Window will 
be filled with the list of parameters that were last saved using the Save Selections button.

Select Defaults – The Select Defaults button adds the most commonly used parameters to the 
Watch Window.  

Select I/O – The Select I/O button will add the Drive and Module digital inputs and outputs 
to the Watch Window.

Close – The Close button will close the Select Drive Parameters window, while the Watch 
Window will remain open.

Help – The help button will give associated help on the Watch Window setup.

User Level - The User Level setting is a filter for the parameters that are seen in the Select 
Drive Parameters list.  If set to Easy, the parameters used in most basic applications will be 
seen while the more advanced parameters are hidden.  If set to Detailed, the parameters used 
in more advanced applications will be added to the list.  If set to Too Much, then all 
parameters available in the system will be seen in the list.  This allows the user to select the 
User Level they are most comfortable with to avoid confusion.  If a parameter has been 
selected and the User Level is changed, then the selected parameter will remain selected.

Group - The Group setting allows the user to filter the parameters that are displayed in the 
Select Drive Parameters window by group.  The Group defaults to “ALL” so that parameters 
from all groups are seen.  If the user wishes to only see those parameters from a specific 
group, the click on the Group list box and select the group of parameters they wish to see.

Global Where Am I Button (PowerTools Pro)
The Program View, when online and executing a program or sequence of programs, can 
display current  program status. Pressing the Where Am I button on the PowerTools Pro 
toolbar creates a blue triangle that appears on the line of the program currently being 
executed. 

The Global Where Am I can be used for diagnostics. When the user needs to know where in 
a complicated program the drive is or when the user wishes to follow the logical flow of the 
program.
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Motion Status (PowerTools Pro)
While the drive is online, the name of the program currently running or the motion type 
currently running will appear in the status bar at the bottom left corner of the PowerTools Pro 
screen.
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Specifications (All FMs)
Ambient temperature range for rated output: 32°F to 104°F (O°C to 40°C)
Maximum ambient operating temperature: 104°F to 122°F (40°C to 50°C) with power 
derating of 3%/°C
Rated altitude: 3,280 feet (1000 m)
Vibration: 10 to 2000 Hz at 2g
Humidity requirement: 10 to 95% non-condensing
Storage temperature: -13 °F to 167 °F (-25 °C to 75 °C)
Approximate Weight: 0.40 lbs (0.18 kg)

Power consumption: 3 W from EN  drive power supply.
I/O Supply Voltage: +10 Vdc to +30 Vdc.

Function Electrical Characteristics

Inputs

ON State Voltage +10 Vdc to +30 Vdc

ON State Current 2 mA to 6.5 mA

OFF State Voltage 0 to 3 Vdc

OFF State Current 0 to 400 µA

Outputs

Max. ON State Voltage I/O Supply Voltage -1.5 V

Max. ON State Current 150 mA

Max. OFF State Current 100 µA
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Dimensions and Clearances

 Figure 25: Typical Dimensions of FM Module (FM-3 Module shown)
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Specifications (All FMs)
 Figure 26: FM Module Installed (FM-4 shown)

AX4-CEN
CDRO
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Cable Diagrams

Drive Signal CMDX, CMDO, ECI-44 CDRO AX4-CEN

Analog In + X X X

Analog In - X X X

Encoder Out A X X X

Encoder Out A/ X X X

Encoder Out B X X X

Encoder Out B/ X X X

Encoder Out Z X X X

Encoder Out Z/ X X X

Pulse In A X X

Pulse In A/ X X

Pulse In B X X

Pulse In B/ X X

Pulse In Z X

Pulse In Z/ X

Pulse In A (single ended) X X

Pulse In B (single ended) X X

I/O Input Drive Enable X X X

I/O Input #1 X

I/O Input #2 X

I/O Input #3 X

I/O Input #4 X X X

I/O Output #1 X X X

I/O Output #2 X X X

I/O Output #3 X X X

I/O Power + In (1st wire) X X X

I/O Power + In (2nd wire) X X X

I/O Power 0 V In (1st wire) X X X

I/O Power 0 V In (2nd wire) X

Analog Out 0V X X X

Analog Out #1 + X X X

Analog Out #2 + X X X

External Encoder +5 Power Out (200 mA) X X X

+15 V Power Out (10 mA) X

RS-485 + X

RS-485 - X
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Specifications (All FMs)
CMDX-XXX Cable

Note
Some CMDX cables may have White/Yellow and Yellow/White wires in place of the 
White/Orange and Orange/White shown in the figure above (pins 6 and 21).

Pin 1

  Pin 1      

24

BLU/BLK

BLK/BLU

P

25

39

BLU/WHT

GRN/WHT

WHT/BLU

BRN/RED

RED/BRN

ORG/WHT

WHT/ORG

BLU/PUR

PUR/BLU

WHT/RED

RED/WHT

RED/BLU

PUR/GRY

BLU/RED

GRY/PUR

WHT/GRN

8

P

P

19

23

18

17

12

16

9

11

P

6

21

4

3

1

2

P

P

P

P

P

Drain Wires

43

Input I/O 1

RS-485-

Sync Encoder Input Z

Sync Encoder Input Z/

24V I/O

OV I/O

Input I/O 2

Motor Encoder Output A

Ext Encoder 200 mA max +5 V

Motor Encoder Output A/

Ext Encoder 200 mA max Common

RS-485+

Input I/O 3

Input I/O 4

Drive Enable Input

Output I/O 3

Output I/O 2

Output I/O 1

Motor Encoder Output B

Motor Encoder Output B/

Sync Encoder Input A/

Sync Encoder Input A27

41

34

32

33

31

37

38

40

26

14

15

29

28

OV I/O

24V I/O

Motor Encoder Output Z/

Sync Encoder Input B

Sync Encoder Input B/

Motor Encoder Output Z

Analog out AG 1 and 2

Command Input-

44

20

36

Command Input+

ENV+

Analog out 1+

Not Used

Not Used

Analog out 2+

GRY/YEL

YEL/GRY

P

BRN/PUR

PUR/BRN

P

BRN/YEL

YEL/BRN

P

BLU/YEL

YEL/BLU

P

RED/BLK

BLK/RED

P

BRN/BLK

BLK/BRN

P

GRN/BLK

BLK/GRN

P

PUR/GRN

GRN/PUR P

ORG/PUR

PUR/ORG

P

See Note below

Note: Inner foil shields are already mechanical connected to
outer braid shield by raw cable manufacture.

31

43

36

20

44

28

29

15

14

26

40

38

37

33

32

34

21

23

41

27

39

25

24

16

17

18

19

11

9

12

8

1

2
3

4

6
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CMDO-XXX Cable

Note
Some CMDO cables may have White/Yellow and Yellow/White wires in place of the 
White/Orange and Orange/White shown in the figure above (pins 6 and 21).

Pin 1

24

BLU/BLK

BLK/BLU

P

25

39

BLU/WHT

GRN/WHT

WHT/BLU

BRN/RED

RED/BRN

ORG/WHT

WHT/ORG

BLU/PUR

PUR/BLU

WHT/RED

RED/WHT

RED/BLU

PUR/GRY

BLU/RED

GRY/PUR

WHT/GRN

8

P

P

19

23

18

17

12

16

9

11

P

6

21

4

3

1

2

P

P

P

P

P

Drain Wires

43

Input I/O 1

RS-485-

Sync Encoder Input Z

Sync Encoder Input Z/

24V I/O

OV I/O

Input I/O 2

Motor Encoder Output A

Ext Encoder 200 mA max +5 V

Motor Encoder Output A/

Ext Encoder 200 mA max Common

RS-485+

Input I/O 3

Input I/O 4

Drive Enable Input

Output I/O 3

Output I/O 2

Output I/O 1

Motor Encoder Output B

Motor Encoder Output B/

Sync Encoder Input A/

Sync Encoder Input A27

41

34

32

33

31

37

38

40

26

14

15

29

28

OV I/O

24V I/O

Motor Encoder Output Z/

Sync Encoder Input B

Sync Encoder Input B/

Motor Encoder Output Z

Analog out AG 1 and 2

Command Input-

44

20

36

Command Input+

ENV+

Analog out 1+

Not Used

Not Used

Analog out 2+

GRY/YEL

YEL/GRY

P

BRN/PUR

PUR/BRN

P

BRN/YEL

YEL/BRN

P

BLU/YEL

YEL/BLU

P

RED/BLK

BLK/RED

P

BRN/BLK

BLK/BRN

P

GRN/BLK

BLK/GRN

P

PUR/GRN

GRN/PUR P

ORG/PUR

PUR/ORG

P

See Note below

Note: Inner foil shields are already mechanical connected to
outer braid shield by raw cable manufacture.
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Specifications (All FMs)
CDRO-XXX Cable

GRN/PUR

Pulse Input A

Pulse Input A/

27

41

Drain Wire

PUR/GRN P

Diagnostic Output 2

Diagnostic Output 1

I/O Supply +

I/O Common -

Output #3

Output #2

Encoder Output A/

Encoder Output A

Encoder Output B/

Encoder Output B

Encoder Output Z

Encoder Output Z/

Drive Enable Input
Analog Command Input -

I/O Supply+

Analog Command Input +

Diagnostic Output Common

Output #1

RED/BLU

YEL/GRY

17

33

44

43

31

18

19

BRN/BLK

GRN/WHT

WHT/GRN

YEL/BRN

BRN/YEL

BLK/BRN

GRY/PUR

PUR/GRY

14

29

15

N/C

34

16

GRY/YEL

RED/WHT

WHT/RED

BLU/WHT

WHT/BLU

BLK/GRN

GRN/BLK

BLU/RED

P

P

P

P

P

P

P

P

P

8

37

38

24

23

9

PUR/BRN

BRN/PUR

PUR/ORG

ORG/PUR

PUR/BLU

BLU/PUR

P

P

P

Input #44

Pulse Input B

Pulse Input B/

26

40

Encoder +5 Vdc Supply11

Encoder Supply Common12

N/C
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TIA-XXX Cable

DDS-XXX Cable

Pin 1

Pin 1

BLK

WHT

BLU
3

5

2 3

2

5

DB-9 MALE
P3

P1
DB-9 MALE

DB-9 FEMALE
P2

DB-9 MALE

DB-9 MALEFEMALEDB-9
P2

8
1

9
6
7

4
3
2
5

SHELL
DRAIN
WIRE

BLACK

BLUE
WHITE

WIRING DIAGRAM

P1

8
1

485-

485+

TX

9
6
7

4
3

RX

GND

2
5

485-

485+4
9

3
2

GND5

P3
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Specifications (All FMs)
TERM-H (Head) Terminator

TERM-T (Tail) Terminator 

Note
See the "Multi-drop Communications" section in the particular FM Module’s reference 
manual for resistor values.
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CMDS-XXX Cable

CMMS-XXX Cable

3 3/4" MAX.1 1/2" MAX.

GRN/YEL

BRN

BLK

BLUC

B

D

AR

S

T

PE/GND

BRAID SHIELD FORM WIRE

1 1/2" MAX.

GRN/YEL

BRN

BLK

BLUC

B

D

AR

S

T

PE/GND

BRAID SHIELD FORM WIRE
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Specifications (All FMs)
CFCS-XXX Cable

Pin 1

P

P

P

P

P

P

P

P

BLU

ORN

GRN

BRN

BLK

YEL

WHT/BRN

BRN/WHT

WHT/GRY

GRY/WHT

RED/ORG

ORG/RED

RED/BLU

BLU/RED

RED/GRN

GRN/RED

E

V

A

T

K

H

F

G

M

P

N

B

R

S

C

U

Z

A

A/

B

B/

Z

Z/

U

U/

V

V/
W

W/

+5 Vdc

GND

MOTOR OVERTEMP

NOT USED

4

16

17

9

15

7

5

14
6

13

3

12

2

11

10

1

U

MOTOR OVERTEMP

NOT USED

+5 VDC

GND

W/

V

W
V/

U/

Z

Z/

B/

B

A/

A
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CFCO-XXX Cable

Pin 1

P

P

P

P

P

P

P

P

GRY/WHT

RED/ORG

ORG/RED

RED/BLU

RED/GRN

BLU/RED

GRN/RED

BRN/WHT

WHT/GRY

WHT/BRN

BLK

YEL

ORN

GRN

BRN

BLU1

10

2

11

3

12

4

13

5

14
6

15

7

17

9

16

V/

MOTOR OVERTEMP

+5 VDC

GND

W/

NOT USED

W

U

V

U/

Z

Z/

A/

B/

B

A
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Specifications (All FMs)
CFOS-XXX Cable

3 3/4" MAX.

1 1/2" MAX.

P

P

P

P

P

P

P

P

BLU

ORN

GRN

BRN

BLK

YEL

WHT/BRN

BRN/WHT

WHT/GRY

GRY/WHT

RED/ORG

ORG/RED

RED/BLU

BLU/RED

RED/GRN

GRN/RED

E

V

A

T

K

H

F

G

M

P

N

B

R

S

C

U

Z

U

MOTOR OVERTEMP

NOT USED

+5 VDC

GND

W/

V

W
V/

U/

Z

Z/

B/

B

A/

A
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Sync Cable Diagrams (All FM-3 and FM-4 Models)

 Figure 27: Sync Cable Connections and Options (FM-4 shown)

SCSLD-x
Encoder

EN Drive
w/ FM-4

EN Drive
EN Drive
w/ FM-4

EN Drive
w/ FM-4

EN Drive
w/ FM-4EN Drive

w/ FM-4

SNCE-xxx
15’, 25’ or 50’

SNCI-003
3’

SNCO-003
3’

SNCDD-001.5
1.5’

SNCI-003
3’

SNCI-003
3’

SNCI-003
3’

CMDX-xxx

Command
Connection, J5
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Specifications (All FMs)
SNCE-XXX Cable

SNCDD-001.5 Cable

Pin 1

C

J

D

A

B

I

H

F

1 RED/WHT

6

8

7

3

5

2

DRAIN WIRE

BLK

RED

BLU

BLK/WHT

BLU/WHT

YEL/WHT

YEL
P

P

P

P

4

A+

A-

B+

B-

Z+

Z-

+5 Vdc

GNDGND

+5 Vdc

Z-

Z+

B-

B+

A-

A+

3

5
41

2
7

8

6

1
2 5

4

3
6

8

7

Completely remove pin 4

4

P
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SNCO-003 Cable

SNCI-003 Cable
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SNCLI-003 Cable
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